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1. Introduction 

Interferon gamma (IFN-γ) is a type II interferon produced by activated T cells, particularly 

CD8+ T cells and Th1 CD4+ T cells [1]. IFNγ is a well-established biomarker of T cell 

activation [2]. IFNγ produced by T-lymphocytes in response to immunotherapies and vaccines 

informs about the desired efficacy of these products because this cytokine plays a key role in the 

immune defense against cancer and infections [3]. In contrast, IFNγ produced as a result of 

undesirable T cell activation may inform about product safety, as overt T-lymphocyte activation 

is associated with T cell-mediated hypersensitivity and autoimmune reactions [4, 5]. Therefore, 

monitoring IFNγ secretion by immune cells exposed to drugs, immunotherapy, or vaccine 

products aids in preclinical efficacy and safety studies.  

IFNγ can be detected using traditional single-plex enzyme-linked immunosorbent assays 

(ELISA) as well as multiplex ELISAs, in which IFNγ can be one of several other cytokines, and 

Enzyme-Linked Immunosorbent Spot assays (ELISpot). The ELISpot format is helpful to verify 

the results of traditional and multiplex ELISAs. It can also be used when IFNγ is the primary 

cytokine of interest. Advantages and limitations of the ELISpot assay vs. multiplex ELISA have 

been discussed elsewhere [6]. This document describes a protocol for IFNγ detection using the 

ELISpot assay. 

 

2. Principles 

In this protocol, human peripheral blood mononuclear cells (PBMCs) from healthy donor 

volunteers are exposed to controls and test samples for 24 hours on 96-well PVDF-backed 

ELISpot plates coated with IFNγ capture antibodies. At the end of the incubation, the cells are 

washed away, and IFNγ captured by the antibodies immobilized on the ELISpot plate is detected 

using biotinylated IFNγ detection antibody, alkaline-phosphatase conjugated streptavidin, and a 

BCIP/NBT substrate, which forms a blue-black colored precipitate. The precipitate co-localizes 

with IFNγ-producing cells, which appear as spots on the plate. These spots are next analyzed 

using the ELISpot reader, which produces two readouts: the number of spots and activity. The 

number of spots reflects the number of cells that produce IFNγ. The activity readout reflects the 

brightness of the blue-black color and, therefore, indicates the quantity of IFNγ produced by a 

single cell. This protocol utilizes freshly isolated PBMCs, the IFNγ ELISpot kit from R&D 
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Systems, and the AID multispot reader for plate analysis. Experimental steps involving 

instrument settings, plate reading, and analysis are based on a series of technical documents by 

R&D Systems [7] and Autoimmun Diagnostika GmbH [8-11]. When other cells, kits, and 

instruments are used for this analysis, the assay principle remains unchanged; however, some 

experimental parameters, such as seeding cell density, incubation time, and spot analysis 

algorithm, may need to be adjusted.  

 

3. Reagents, Materials, Cell Lines, and Equipment 

Note: The NCL does not endorse any of the suppliers listed below; these reagents were used 

in the development of the protocol, and their inclusion is for informational purposes only. 

Equivalent supplies from alternate vendors can be substituted. Please note that suppliers 

may undergo name changes due to various factors. Brands and part numbers typically 

remain consistent but may also change over time. 

 

3.1 Reagents 

3.1.1 Human IFNγ Kit (R&D Systems, EL285) 

3.1.2 RPMI-1640 (Cytiva, HyClone, SH30096.01)  

3.1.3 Penicillin streptomycin solution (Cytiva, Hyclone, SV30010) 

3.1.4 L-glutamine (Cytiva, Hyclone, SH30034.01) 

3.1.5 Fetal bovine serum (FBS) (Cytiva, Hyclone, SH30070.03) 

3.1.6 Phosphate-buffered saline (PBS) (Cytiva, SH30256.01) 

3.1.7 Trypan Blue solution (Gibco, 15250-061) 

3.1.8 Phytohemaglutinin (PHA-M) (Sigma, L8902) 

3.1.9 Sterile distilled water 

3.2 Materials 

3.2.1 Pipettes covering the range of 0.05 to 10 mL 

3.2.2 Polypropylene tubes, 50 and 15 mL 

3.2.3 Reagent reservoirs 

3.3 Equipment 

3.3.1 Centrifuge  

3.3.2 Refrigerator, 2–8°C 
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3.3.3 Freezer, -20°C 

3.3.4 Cell culture incubator with 5% CO2 and 95% humidity 

3.3.5 37°C water bath 

3.3.6 Biohazard safety cabinet approved for level II handling of biological 

material 

3.3.7 Inverted microscope 

3.3.8 Vortex 

3.3.9 Hemocytometer or automated cell counter 

3.3.10 AID multispot reader 

 
4. Preparation of Reagents and Controls for Cell Culture 

4.1 Complete RPMI-1640 Medium  

10% FBS (heat-inactivated) 

2 mM L-glutamine 

100 U/mL penicillin 

100 µg/mL streptomycin sulfate 

Store at 2–8°C protected from light for no longer than 1 month. Before use, warm 

in a water bath. 

4.2 Heat-inactivated Fetal Bovine Serum 

Thaw a bottle of FBS at room temperature, or overnight at 2–8°C, and allow to 

equilibrate to room temperature. Incubate for 30 minutes at 56°C in a water bath, 

mixing every 5 minutes. Fifty (50) mL single-use aliquots may be stored at 2–8°C 

for up to one month or at a nominal temperature of -20°C indefinitely. 

4.3 Negative Control 

Use PBS as a negative control. Process it the same way as your study samples. 

4.4 Positive Control 

PHA-M at a final concentration of 10 µg/mL is used as a positive control in this 

assay. The stock with a concentration of 1 mg/mL can be prepared in PBS or 

medium and stored in small, single-use aliquots at -20°C.  
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Note: Other T cell agonists, such as concanavalin A, PMA/Ca2+ ionophore, and 

anti-CD3 antibody alone or in combination with anti-CD28 can also be used at 

relevant concentrations. 

4.5 Vehicle Control 

Vehicle control is the buffer or media used to formulate test nanomaterials. 

Common excipients used in nanoformulations are trehalose, sucrose, and albumin. 

However, other reagents and materials are also used alone or in combination. 

Vehicle control should match the formulation buffer of the test nanomaterial in 

both composition and concentration. This control can be skipped if nanoparticles 

are stored in PBS. 

 
5. Preparation of Study Samples 

The required amount of nanoparticles will depend on the number of concentrations tested, the 

number of replicates, and the nanoparticle stock concentration. The minimum required dilution 

(MRD) of this assay is 2; therefore, the working stock concentration of the test sample should be 

2-times higher than the final concentration desired for analysis in this assay. For example, if one 

desires to test nanoparticles at 1 mg/mL, the working stock concentration should be 2 mg/mL. 

The recommended minimum volume of the working stock is 450 μL for 3 donors (50 μL per 

well, in duplicate, plus extra to prepare dilutions and account for dead volume of pipette tips and 

sample tubes). A strategy for estimating nanoparticle test concentrations for in vitro testing has 

been discussed elsewhere [12]. 

 

6. PBMC Preparation 

6.1 Place freshly drawn blood into 15- or 50-mL conical centrifuge tubes. Add an 

equal volume of room-temperature PBS and mix well.  

6.2 Slowly layer the Ficoll-Paque solution underneath the blood/PBS mixture by 

placing the tip of the pipette containing Ficoll-Paque at the bottom of the blood 

sample tube. Alternatively, the blood/PBS mixture may be slowly layered over 

the Ficoll-Paque solution. Use 3 mL of Ficoll-Paque solution per 4 mL of 

blood/PBS mixture. For example, 15 mL Ficoll-Paque per 20 mL of diluted blood 

in a 50 mL tube. 
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Note: To maintain Ficoll-blood interface it is helpful to hold the tube at a 45° 

angle.  

6.3 Centrifuge 30 min at 900xg, 18–20°C, without brake.  

Note: Depending on the type of centrifuge, one may also need to set the 

acceleration speed to a minimum. 

6.4 Using a sterile pipette, remove the upper layer containing plasma and platelets 

and discard.  

6.5 Using a fresh sterile pipette, transfer the mononuclear cell layer into a new 

centrifuge tube.  

6.6 Wash cells by adding an excess of HBSS and centrifuge for 10 min at 400xg, 18–

20°C. The HBSS volume should be ~3 times the volume of the mononuclear 

layer.  

Note: Typically, 4 mL of blood/PBS mixture results in ~ 2 mL of mononuclear 

layer and requires at least 6 mL of HBSS for the wash step. We use 10 mL of 

HBSS for each 2 mL of cells. 

6.7 Discard supernatant and repeat the wash step once more. 

6.8 Re-suspend cells in complete RPMI-1640 medium. Dilute cells 1:5 or 1:10 with 

trypan blue, count cells, and determine viability using trypan blue exclusion. If 

viability is at least 90%, proceed to step 6.9. 

6.9 Dilute cells to a concentration of 1.0 x 106 viable cells per 1 mL, so that each 50 

µL aliquot of this cell suspension, when plated per well on the ELISpot plate, 

contains 50,000 cells per well.  

 

7. Set-up ELISpot Plate 

7.1 Fill all wells of the ELISpot plate with 200 µL of sterile culture medium and 

incubate for 20 minutes at room temperature. 

Note: This step is intended for wetting the PVDF membrane; the medium will be 

discarded later, in step 7.2, before loading the treatments and PBMC cells. 

7.2 Aspirate 200 µL of the culture medium from the ELISpot plate prepared in step 

7.1. 

7.3 Add 50 µL of controls and treatments to the appropriate wells of the plate. 
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Note: It is advisable to use positive control samples in wells A1, A12, and H12 to 

facilitate stage calibration. Please consider the plate map in the Appendix of this 

protocol as an example of plate setup. 

7.4 Seed 50 µL of cells from step 6.9 into the appropriate wells of the plate prepared 

in step 7.3.  

7.5 Incubate at 37°C, 5% CO2, and 90–95% humidity for 20–24 hours.  

Note: During the incubation, it is important to avoid disturbing the plate. 

7.6 At the end of the incubation, remove the plate from the incubator and continue to 

detect INFγ using the IFNγ ELISpot kit according to the manufacturer’s 

instructions. 

 

8. IFNγ Detection (R&D Human IFNγ Kit) 

Note: The procedure described in this step is specific to the R&D Systems kit. When kits from 

other manufacturers are used, the steps outlined below may vary. 

8.1 ELISpot Reagent Preparation 

8.1.1 Warm all reagents to room temperature except for the Human IFN-γ 

detection antibody and Dilution Buffer 1. 

8.1.2 Wash Buffer: Make sure any visible crystals have been dissolved by 

gentle mixing. Add 50 mL of wash buffer to 450 mL of deionized water. 

8.1.3 Human IFN-γ Positive Control: Reconstitute with 250 µL of cell culture 

medium. 

8.1.4 Detection Antibody Mixture: Immediately before use, transfer 100 µL of 

human IFN-γ detection antibody to the Dilution Buffer 1 vial and mix 

well.  

8.1.5 Streptavidin-AP Concentrate A: Immediately before use, transfer 100 µL 

of Streptavidin-AP Concentrate A to the Dilution Buffer 2 vial and mix 

well.  

8.2 ELISpot Procedure for IFNγ Detection  

8.2.1 Wash the plate from step 7.5 with 250–300 µL of the previously prepared 

wash buffer. Repeat three times for a total of four washes. 
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8.2.2 Add 100 µL of diluted detection antibody and incubate overnight at 2–8°C 

or, alternatively, on a rocker at room temperature for 2 hours. 

8.2.3 Repeat the wash procedure in step 8.2.1. 

8.2.4 Add 100 µL of diluted streptavidin-AP and incubate for 2 hours at room 

temperature. 

8.2.5 Repeat the wash procedure in step 8.2.1. 

8.2.6 Add 100 µL of BCIP/NBT substrate to each well and incubate for 1 hour 

at room temperature, protected from light. 

8.2.7 Remove the substrate and rinse the plate with deionized water. Invert the 

plate and blot on paper towels. 

8.2.8 Remove the flexible plastic underdrain and wipe with paper towels, dry 

completely at room temperature for 60–90 minutes or, alternatively, at 

37°C for 15–30 minutes. 

8.2.9 Read plate on the ELISpot Reader. 

8.3 AID Reader Start-up and Plate Read (Refer to the instrument and software 

manuals for more detailed instructions.) 

8.3.1 Turn on the AID multispot reader, light sources, and computer. 

8.3.2 Launch the AID software and choose the ELISpot button. 

 
 

8.3.3 Above the menu bar, check the user profile. If it reads User: IFN-γ 

Enzymatic Elispot Protocol, go to step 8.3.6. If not, under File on the 

menu, click on Options, then click User Profiles in the newly opened 

Options window. 
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8.3.4 In the user profile window, highlight IFN-γ Enzymatic ELISpot 

Protocol, click Log In, enter the user password, and then click OK. 

Note: Each user should have their own password to operate this software 

on their computer. 

8.3.5 Click OK in the Options window to close. 

 
 

8.3.6 Under the File menu, click New. This should open a plate template with 

the ITA-41 settings. Remember to save the file under a new name.   

8.3.7 To add information on cell lines used, cells/well, and treatments, click on 

the Tools menu, click Plate Layout, then click Edit Layout. This will 

open the Wells Properties window. 



NCL Method ITA-41 July 2025             11 
Version 1 

 
 

8.3.8 Under the Tools menu, choose Calibrate Stage and choose well A1; 

center and adjust the imaging ring to encompass most of the well. Do the 

same for wells A12 and H12. Click Save and OK to save the stage 

calibration. 

 
 

8.3.9 On the plate map, use the mouse to select the wells to be read, then right-

click and highlight Read, Count & Analyze on the drop-down menu. 

8.3.10 After the plate has been read, click the Save button.  
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9. Results and Analysis 

If necessary, the analysis algorithms and count settings may be changed from the AID 

default. This may be done before or after the plate is read. 

9.1 Once the plate has been read and analyzed, click the Excel button on the menu 

bar. This will open an Excel file with the spot counts and activities for each of the 

selected wells.  

9.2 Images of the plate and individual wells may be selected and captured using the 

PowerPoint button on the menu bar or by using the Print Screen function. 

9.3 Plate and well information may be captured by clicking Tools, Plate Layout, then 

View Layout. 
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11. Abbreviations 

AID  Advanced Imaging Devices (Autoimmun Diagnostika) 

BCIP/NBT 5-bromo-4-chloro-3-indolyl phosphate / nitro blue tetrazolium 

CF  cell-free 

FBS  fetal bovine serum 

PBMC  peripheral blood mononuclear cells 

PBS  phosphate buffered saline 

PC  positive control 

PHA-M Phytohemaglutinin M  

RT  room temperature 

T  test sample 

 

 



NCL Method ITA-41            July 2025   15 
Version 1 

12. Appendix 

Example Plate Map 

 
Wells A1, A12, H12: PBMC + PC for stage calibration 

Rows A, H: Cell-free (CF) controls 

Rows B, C: Donor 1 

Rows D, E: Donor 2 

Rows F, G: Donor 3 

 
PC, positive control; CF, cell-free well;  
T, test sample (at 4 different concentrations, i.e., T1, T2, T3, T4) 

 

 1 2 3 4 5 6 7 8 9 10 11 12 

A PC Cell-free CF 
PC 

CF 
T1 

CF 
T2 

CF 
T3 

CF 
T4     PC 

B Untreated Untreated PC PC T1 T1 T2 T2 T3 T3 T4 T4 

C Untreated Untreated PC PC T1 T1 T2 T2 T3 T3 T4 T4 

D Untreated Untreated PC PC T1 T1 T2 T2 T3 T3 T4 T4 

E Untreated Untreated PC PC T1 T1 T2 T2 T3 T3 T4 T4 

F Untreated Untreated PC PC T1 T1 T2 T2 T3 T3 T4 T4 

G Untreated Untreated PC PC T1 T1 T2 T2 T3 T3 T4 T4 

H  Cell-free CF 
PC 

CF 
T1 

CF 
T2 

CF 
T3 

CF 
T4     PC 
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